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1 - Introduction                                                 
 

1.1 Why Wordpress? What is a Content Management System?
Wordpress is the simplest and most powerful blog-
ging platform available today, powering over 50% of 
all blogs. It makes the task of content-management 
easy for anyone. 

What is a content management system? In the past, 
creating a website meant writing a new .html file 
for every page - either in raw HTML code or using 
some kind of website designer application - you’ve 
probably learnt a little HTML yourself at some point. 
However, writing an entire HTML file for every new 
post you want to write becomes rather tedious - and 
then you’d have to update the sidebar in every page 
with links to your new post every time you wrote 
something new… and it all becomes a bit of mess, 
really. Beyond very small sites, the management 
needed for everything skyrockets.This is where a 
content management system (a CMS) like Wordpress comes to the rescue. A content management system separates 
out the content in a site - the text and images that form the individual articles and pages - from the template, the HTML 
code, the CSS, the javascript and all the little elements of a webpage that don’t change from page to page. 

By separating out the content of your pages from the layout, Wordpress can then dynamically generate new HTML 
files every time someone visits your site. Wordpress also takes care of automatically linking your posts together, creat-
ing the sidebar with links to your latest content items, and managing the archives. In fact, because Wordpress works 
from HTML theme templates that you can download, you don’t ever need to write a single line of HTML code - all you 
need to worry about is writing the actual content and uploading your pictures. Wordpress takes care of the website 
coding, you just supply the content. It’s this separation of template and content that opened the world of running a 
website - a blog - to the world. 

Although Wordpress is most commonly used to create a blog-style site - which is technically just a series of posts with 
a specific date and time that they were posted - it can also be easily adapted to suit static websites, such as for your 
local business, artist portfolio, or even a complete online shopping site. As you delve into Wordpress, you’ll find that 
there’s a Wordpress plugin to create literally any kind of website you could possibly think of. 

Wordpress isn’t the only CMS around though, so why choose Wordpress? Simple:

• It’s feature rich, so with the basic installation you should be able to everything you want to. If some-
thing is missing for your particular requirements, it’s highly likely there is a plugin already made to 
handle it for you. The upshot is, you don’t need to code anything. 
• It’s mature - created in 2003, it’s had a very long life so far and continues to be in active development. 
This isn’t buggy new beta-release software - it’s incredibly stable. 
• It’s secure. As with any piece of software or operating system, there have been a few serious hacks 
over the years but the developers have been on top of them quickly. The latest versions include 
prominent warnings when a new version is available, and so long as you regularly check your blog and 
update when needed, there’s very little chance of your blog being hacked. 

Still not convinced?

• It’s incredibly easy to install
• There are literally thousands of plugins to add functionality 
• Image and media management out of the box for instant portfolio and photo driven sites
• Simple coding for core functionality makes it easy for novice programmers to customize their blog at 
a code level - however I won’t be addressing any coding in this guide. 
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1.2 What’s The Difference 
Between Wordpress.org and 
Wordpress.com?
Many people are understandably confused about the difference between Wordpress.com and Wordpress.org, so let’s 
take a moment to go over this before we begin. 

Wordpress.com will give you a free blog, hosted on Wordpress’ own servers. It’s most suitable for absolute beginners 
- you don’t need to worry about configuring files or databases and everything is taken care of for you. A Wordpress.
com blog is similar to any other online blog service like Blogspot or Tumblr. It’s the absolute easiest way to begin with 
Wordpress, but it’s very restrictive in the plugins and themes you can use - essentially you get to choose from a limited 
catalogue of pre-chosen styles and approved plugins. 

Wordpress.org, on the other hand, is the site from which you can download the self-hosted Wordpress system and 
upload it to your own server. You’ll need a server capable of running PHP, and a MySQL based database. Setting up 
a self-hosted blog is a little more difficult (think 5 minutes instead of 1), but you get a lot more freedom to do as you 
wish, customize how you like, and it’s easy to have your own domain from the start. The majority of this guide will refer 
to the self-hosted wordpress.org version. 

To add further confusion, many web hosts will offer one-click Wordpress.org installs which will install the files and set 
up the database for you - so you don’t need to configure anything! If you choose to host with a shared server, this is 
the recommended option.

1.3 Domain Considerations
If you do choose to use the free wordpress.com blog option, your blog address will be something.wordpress.com 
(known as a “sub domain”) - you can use your own domain, but it’s a paid upgrade - at which point I feel like you may 
as well just buy your own hosting. It’s also worth considering the future - a free sub domain of wordpress.com may 
sound fine now to get started, but if your blog ever becomes popular - or you’d like it to - having your own personal 
domain is of paramount importance. We’ll cover that later in this guide in the section on basic “search engine optimiza-
tion”, but if you’re concerned and want to know more about why you should have your own domain, skip forward now. 

1.4 Hosting options for Wordpress.org Self Hosted Version
Budget web hosting is a really competitive area and the options vary enormously, so I would be very careful when 
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choosing your host. 

1.4.1 Key Terms and Considerations: 
Let me explain a few key terms you need to know and consider first, before going on to suggest providers I’ve person-
ally used over the years and can heartily recommend.

CPanel: This is an industry standard piece of software that controls your hosting, such as setting up mail accounts or 
databases. It may take a while to learn, but it’s the default with most hosts so when you’ve used it once you will know 
it all. It also usually contains a module called Fantastico, which is a one-stop installer for Wordpress and other web 
apps: just enter the site name, password, etc and it will perform the complicated bits of the installation process for you. 

Bandwidth vs Speed: Most budget hosts will lure you with promises of “unlimited” storage and bandwidth, meaning 
your users can download or browse your blog as much as they like without incurring additional costs on your hosting 
bills. In reality, this is completely offset by the speed that your site will run at - so even if you were to have constant 
downloads from your site, it would be so slow that over the course of the month the actual bandwidth used is minimal. 
So don’t be fooled by these empty promises. There are also strict Terms and Conditions for usage of your hosting 
storage - you might be tempted to think that with unlimited storage, you could backup your entire computer there too~ 
BONUS, right?! But this is generally forbidden, and the storage may only be used for “files specifically related to the 
website”. In short, unlimited bandwidth is misleading, so replace the words “unlimited bandwidth” with “slow speed” 
whenever you see it within a hosts marketing spiel. 

Free Domain: Budget hosts will charge a premium every month but offer you a “free domain” when you open your ac-
count. That free domain might only cost you $8 if you were to purchase it somewhere else though, so be sure to factor 
that it into your cost calculation. Basically: a free domain isn’t worth shouting about. 

Additional Domains: You would be forgiven for thinking that with unlimited hosting you could add as many domains 
as you like, but this isn’t always the case. For one host I mention below, additional domains requires a yearly $30/do-
main on top of the actual domain registration fee. 

Databases: Some hosts will give you access to standard databases, while some will give you a separate “hosted 
database” instead, which means it’s held on a separate remote server. Hosted databases are more difficult to set up 
manually with Wordpress, and it took me hours to figure out why my fresh Wordpress wouldn’t install the first time I 
tried. Of course, you can get around this by using the host’s special application installer (Fantastico or similar), but I 
prefer to roll my own clean copy of Wordpress.

CPU cycles: With budget shared hosts, there are a large number of users on any one server. This means that while 
your bandwidth or storage may be unlimited, your CPU cycles are most certainly not. A number of times I’ve tried to 
run some new Wordpress plugin on a shared host only to be promptly sent a warning letter saying the CPU cycles 
have jumped and that my account will be terminated within days if I don’t do something about it. 

1.4.2 Straight To The Point - My Recommendations:
For a single site that you never expect to require ad-
ditional domains for (a small business or charity, per-
haps), I recommend SiteGround (http://siteground.
com) for their great support, usability, and speed. 
The price would be $4/month with their current offer. 
Here’s why I recommend them.
 
+ Great performance
+ Standard CPanel to access your account
+ Local database so you can install Wordpress your-
self hassle-free. 
+ Standard Fantastico app installer for one click 
installation.
+ Quick response and helpful support

On the downside, SiteGround falls down in just one 
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area:
- Additional fees for hosting another domain

If you have bigger plans to host more than one blog, 
but are still just beginning on the path to your web en-
lightenment, I wholeheartedly recommend GoDaddy 
- but only their *deluxe Linux* hosting plan. Though 
the control panel does leave a lot to be desired and 
makes set up difficult, the plan is truly unlimited and 
very cost effective for running multiple websites, at 
least until your sites outgrow them. The performance 
is quite slow, but at this price ($8/month at the time of 
writing) you can’t expect much. 

+ Very affordable for both hosting and domains (Before I changed hosts, I had 20 websites hosted there on the same 
account), and always easy to find a coupon
+ Custom, but easy to use web application installer. 
- Lots of up-sell for related products
- Substandard custom control panel
- “Hosted” database makes Wordpress custom installation difficult (using the special GoDaddy application installation 
control panel is fine though)
- Performance issues

1.4.3 The Next Level: Virtual Private Server
When the performance of a shared server has become just too slow for you or your site traffic is resulting in regular 
warnings from your host, it’s time to move up to the next level of hosting - your own virtual private server. With shared 
hosting, you’re crammed into a single server with thousands of other users. A virtual private server means that al-
though a single physical server is shared between a number of users, each user has their own virtual machine to do 
with as they wish. You don’t just get a single folder to store your website - you get control of an entire (virtual) server. 

Apart from vastly improved performance, you also have far more control if you want to install unsupported software 
versions, change the underlying web software to something much better performing, or add additional functionality. 
You can do this all through the intuitive control panel or by using a secure shell command line. 

It’s also easier to upgrade a VPS when you require even *more* power - as easy as clicking upgrade and suddenly 
your server now has 2GB of RAM instead of 1GB.

KEY POINTS OF A VPS:
+ Incredible performance
+ Complete control over server and software run-
ning on it
+ Command line access (SSH) for easy backup 
+ Easy to scale when more power is needed
- $50/month

So where’s the best VPS hosting provider and how 
much does it cost? Personally, I host with Media-
Temple, and the basic VPS package is $50/month 
for up to 100 domains. I currently host around 20 
sites with reasonable traffic on the basic plan, and 
they’re blazingly fast.

1.5 Installation methods:
As I mentioned, you can either use the standard Fantastico installer that came with your hosting to set up your new 
Wordpress for you, or download and attempt to install it yourself. I suggest you try both, to be honest, as downloading 
and FTPing the files yourself is good practice and you have a chance to look at the directory and file structure behind 
Wordpress. You’ll also need to set up a fresh database for Wordpress to use, so it’s a good way to learn the ins-and-
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outs of CPanel. 

Rather than repeat the great information already out there, I’ll point you in the direction of the Wordpress codex which 
contains full instructions for setting up Wordpress using the industry standard Cpanel. (http://codex.wordpress.org/
Installing_WordPress#Using_cPanel)

For the faint of heart or impatient, hit the Fantastico installer button, and choose a username and password. GoDad-
dy’s own brand software centre is much the same.

Logging In:

The admin panel for your Wordpress installation can always be accessed at your domain.com/wp-admin, but if you’re 
already logged in you should see an admin bar at the top of the screen when viewing any non-admin part of your blog.  

http://www.makeuseof.com
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2 - Get Stuck In                                                  

2.1 Key Concepts and Terminology
Wordpress has grown up over the years to encompass a variety of content types, and 
has developed its own terminology, so it would be beneficial to learn that before jumping 
it. Here’s what you need to know before continuing with the guide:

POST - This is the most fundamental type of content that will form the majority of your 
blog. A post consists of a title, the content text itself, a publish date, a category, tags, 
and associated attachments (such as pictures). Blog posts are generally intended to be 
displayed chronologically with the newest appearing first. Monthly archives are auto-
matically generated, as well as an RSS feed of your latest posts. 

PAGE - These were created to house static content for your site that shouldn’t have a 
publish date - such as About Me, or a Contact form. They also don’t need to be tagged 
or categorized, and aren’t included when users browse your blog archives. Generally 
you would use pages for content you want to link to from the front page at all times. 
Pages can also be hierarchical.

CATEGORIES - Generic terms to classify posts. Posts can have one or more catego-
ries, and when users browse a category archive, they will be shown a list of all posts 
in that particular category. You can also assign sub-categories to create a hierarchy if 
your blog needs it. Categories aren’t really optional, though the system itself won’t force 
you - if you fail to categorize something, it will assigned a default category of “uncatego-
rized”. 

TAGS - Tags should describe the post more specifically than categories, and may be 
used by search engines to consider page relevancy. They allow you to create “tag 
cloud” widgets, and also have archive pages similar to categories. They’re not essential, 
but recommended. Not sure how to tag your posts? A good example would be a recipe 
blog, with categories for breads, main dishes, starters, desserts etc. Each recipe might 
then be tagged with the ingredients, so that users could for example, view all bread 
recipes, or view all recipes made (tagged) with flour. 

WIDGETS are little blocks of functionality that you can add to your blog in various 
places, depending on whether your theme supports them - generally they go in the sidebar though. They really can do 
anything and I’ll explain more about them later in chapter 3.4 - 
Widgets; example widgets at top-left.

PERMALINKS - This means the URL from which your page is 
accessed. By default, the permalink to a certain blog post may 
look like yourdomain.com/?id=12345 - which obviously doesn’t 
look that great. Later, I’ll explain how you can change this to 
be “pretty permalinks” of the form yourdomain.com/delicious-
bread-recipe. 

COMMENTS are standard fare for blogs nowadays, but you 
can turn them off. Pages cannot be commented on by default, 
only blog posts. 

THEME is how your blog is displayed, and Wordpress has the 
most free themes of any system - literally hundreds of thou-
sands to choose from. Choosing one can be easy or a night-
mare - so that’s why a whole section of this book is dedicated 
to it. See the key elements of most themes at right. 
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MENUS are a new addition to Wordpress version 3 and they allow you to create custom menus throughout your 
theme (assuming it supports them). We’ll look at this functionality in more detail later, but be aware that many themes 
have not been updated to include this functionality yet. 

FEATURED IMAGES allows you to simply and easily specify an associated image for a post. Once set, themes that 
support featured images will automatically display the image next to the post excerpt or in various places throughout 
the theme. Adding the visual cue next to a post title dramatically increases the likelihood of readers clicking-through 
to read the article. Don’t worry if your theme doesn’t support featured images straight off though - I’ll show you later in 
the book how you can add this functionality in yourself when we dabble in a little theme editing. 

2.2 Essential First Steps
Though the famous 5 minute installation gives you a fully working Wordpress system from the get-go, there are a few 
steps I recommend you take before doing anything else. 

1. Enable Akismet Spam Control: You’ll be amazed at how quickly 
the spammers can find your blog and start comment spamming. I left a 
blog in a basic installation state once, and within a week it acquired 100 
comment notifications for the sample “Hello World!” post. Head over to 
sign up for an Akismet API key first, then activate the Akismet plugin and 
configure your API key. This will automatically catch most spam com-
ments which can quickly overwhelm you.

A Note About Comment Spam:

Be careful about approving innocent-looking non-spam comments or 
those praising your wonderful blog post without mentioning specifics. 
Generic comments are one very successful way that spammers can get 
onto your blog. Even if their name isn’t deliberately spammy, or they’ve 
added a URL such as google.com or bing.com - the spammer knows 
that once their initial non-spam generic comment has been approved, 
they’re free to post whatever they like next time.

2. Edit the site Tagline. After the initial installation, your homepage will be displaying a tagline of “Just another Word-
press Site”. Head to the general settings screen to change this, and don’t forget to save. 

3. Enable “pretty permalinks”. From the settings -> permalinks page you can choose a new URL style so that your 
URL’s have meaning to them. You can customize this however you like, but Wordpress will perform better if it has a 
number of some sort before the name of the post. “Month and name” is a good choice, but my personal preference to 
keep URLs short is to remove the month number 
and just keep the year. To do this, click Custom 
Structure and paste this in the box before saving

: /%year%/%postname%/

(If you get an error that your .htaccess file isn’t 
writeable, just change the root folder of your web 
server - the httpdocs or public_html folder - to have 
755 permissions set)

2.3 Choosing a Theme

2.3.1 Be Wary of Downloading Free Themes From Random Websites:
As with any system that becomes the most popular, people will attempt to exploit unwitting users. For Wordpress, this 
has been in the form of hidden links in theme codes - often to sites of dubious content and encoded in such a way that 
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the theme will break if you attempt to remove them. This is a grey area morally - some theme designers make a living 
from selling these links for advertising fees, and are able to therefore give the theme to you for free. If the theme is 
from a reputable designer - generally you would download these from the designer’s site rather than a theme collec-
tion site - then I’d suggest you leave the link there or pay the designer to have it removed (they usually offer this as 
a premium service). Otherwise, I would say stick to the Wordpress hosted theme archive at wordpress.org, as the 
themes have been vetted and there’s a strong community behind them. Just be careful about Googling “free Word-
press themes”.

More recently, some themes even have malware embedded within them that will turn your website into a spamming 
machine, and I’ve seen the effects of this first hand - in the worst case resulting in a $1,000 bandwidth overage charge 
because the compromised server was sending out spam emails at an alarming rate. So I repeat now, never ever 
download from a non-reputable site - especially something you found after googling “free wordpress themes”.

2.3.2 Where To Download Safely:

Official Wordpress Theme Archive (http://wordpress.org/extend/themes/) - in case you didn’t know, you can access 
this using the Wordpress admin screen itself rather than visiting the actual site. Just select Appearance -> Themes -> 
Install Themes, and either search for keywords or filter by the theme’s tags.

WPShower (http://wpshower.com/), a selection of both premium and free themes, some of which are featured in the 
Photoblog / Portfolio selection below. 

Smashing Magazine (http://www.smashingmagazine.com/): Though primarily a design blog that covers a variety of 
topics, they like to round up the best of the new free themes and regularly sponsor a new theme release of their own, 
so it’s definitely worth subscribing to their feed. 

Site5 (http://www.site5.com/wordpress-themes/)
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“Premium” or paid themes are of course another option, so if you’re willing to spend up to $50 on a unique theme or 
going to a theme “club” then these are some of the best places to start looking:

• WooThemes: The priciest of the lot at $15 a month for unlimited theme access, but great quality. 
• ThemeForest: the largest collection of premium themes, all individually priced. 
• ElegantThemes: a very comprehensive selection and you get unlimited access to them all for $39.

If you’re looking for themes specifically for photo-blogs, skip forward to the chapter on Galleries and Photo Manage-
ment.

I’ll be introducing some more great Wordpress resource sites at the end of the book, but for now you can either begin 
work on your new blog using the default theme, covered in the next chapter, or go ahead and choose a different theme 
from the sources we listed above. 

2.2.3 Twenty-Eleven: The Wordpress 3.2 Default Theme

With the latest 3.2 release of Wordpress came a beautiful new and remarkably capable theme which is fully HTML5 
compliant called Twenty-Eleven. A lot of this new default theme can be customized really easily, so let’s talk a little 
about how to do that. 

1. Header Images: This is the most prominent part of any website, so using your own images, immedi-
ately gives it a personal touch. From the Appearance -> Header section it’s so easy to just upload an im-
age and then crop it to the right dimensions. Upload more than one, and you can even set it to randomly 
rotate. This is a fantastic feature if you have a lot of images you love and want to make your site even 
more dynamic on every page load, and it really does make an incredible difference. 

2. Background Image: Instead of a plain grey background, you can even customize your site with a 
background image. Choose an image that’s big enough to go across the whole screen though, or some-
thing that tiles well. If you’d rather not have an image, changing the color could be just as effective. 
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3. The theme includes both dark and light basic styles to start customizing. Choose these from the Ap-
pearance -> Theme Options. You can also select the basic layout from here too.  

4. Dynamic resizing based upon screen size - this is actually more incredible that it sounds, as it com-
pletely negates the need for special mobile sites and ensures a consistent look and feel across devices 
such as the iPad where screen real estate is at a premium. Try it now by opening your blog homepage 
and resizing it to a really thin browser window.

5. Support for Tumblr-like image only / quote / “aside” post-types. In cases where you don’t feel a whole 
blog entry is appropriate, just change the post-type. “Aside” and “Link” type posts can then be shown in 
your sidebar on the “Ephemera” widget. 

A few downsides too, though. 

For some reason, they decided the template used when viewing a single post should not include the sidebar (perhaps 
it’s too distracting?) To fix this, you can download and use the child theme* from Niraj Chauhan here. (http://webstu-
torial.com/add-sidebar-twentyeleven-theme/content-management-system-cms) Also, featured images work a little 
differently with this theme. Instead of appearing next to the post title on the blog homepage, they allow you to assign 
custom headers to individual posts. If you’d like to use them this way, just make sure your featured image attached to 
posts is at least 1000px wide X 288px tall. 

So before you go off in search of your very own theme, you may want to seriously consider the one that comes with 
Wordpress. For beginners it offers a high degree of customizability and features that you’d be hard pressed to find 
anywhere else for free. 

[* A child theme means that it has customized another existing theme in some way. The child theme by itself won’t 
work - it needs to have the original parent theme also uploaded. To make a child theme active, you would change the 
current theme as you would any other. Child themes are a great way to override or add to an original theme without 
modifying the original files. It also ensures that any theme updates you apply later won’t break or overwrite the chang-
es you made in your child theme].
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3 Basic Operations:                                            
This is going to be the shortest chapter of this book, because Wordpress is so user friendly you really don’t need any 
instruction to get you started on the writing front. In fact, most of the functionality available to you within Wordpress is 
one click away now with the helpful admin toolbar. Once you’re logged into the site, you should see this on any page 
you view on your site. Don’t worry: only you can see it, not your regular visitors. 

3.1 Write Your First Post: 

To write a new blog post, hover over Add New -> Post on the top toolbar. 
It’s that simple. In the admin area, there’s also a button to write a new post 
in the top right, and a link in the Post section on the sidebar at all times. 
Things should be self explanatory from there. 

Hint: If you find yourself having a sudden burst of inspiration, but don’t want 
to publish everything at once - you can set the publish date in the future. 
The Publish button will become Schedule, and at your set time the post will 
be published automatically. Very useful if you’re taking a long holiday.

There are two edit modes when writing a post - the Visual tab will give you 
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a preview of the post - a WYSIWYG view if you like - showing pictures and text formatting you’ve applied. The final 
article will depend on your theme template of course, which is why there’s also a preview button to see your finished 
piece in context and make adjustments. 

3.2 Upload a Picture:
While most of the icons on the post edit screen will be familiar 
to anyone that’s used a computer before, the four on the left 
will be new. The most common one you’ll use is the first, the 
one that looks like a picture frame. 

Click that to open the picture upload dialog. After choosing a 
file on your local machine and hitting upload, you’ll be pre-
sented with the following somewhat confusing screen, so let’s 
look at that in a little detail.

First off, the Edit Image button is quite useful, allowing you 
to crop, rotate, and resize the image. It’s easy to overlook 
though, and for the most part you probably won’t need it. Fol-
lowing on down the screen are some text fields you can enter. 
If you add a caption, it’s going to be displayed on your page 
underneath the picture. The title, alternate text, and descrip-
tion however are hidden. They will be used for either brows-
ers that can’t display images or users with vision impairment, 
or by Google when people perform an image search. Setting 
them is not required other than a title, but if you have a pho-
tograph you’re particular proud of or perhaps a picture you 
created (like an infographic), then it’s well worth setting them. 

Next, the link URL. This determines if users can click on the 
picture for a larger version or not. If you want nothing to hap-
pen, choose none. If you’d like them to be able to open the 
full version of the picture, choose file URL. The Post URL will link the image to its own page (the ‘attachment’ page), 
which looks just like a regular post but only contains that picture. Since you’ll generally be inserting images at a good 
size fit for the theme, linking to a separate attachment page is somewhat redundant - best to link to the full file URL if 
you do actually want users to be able to view the full image at all. 

Alignment determines whether the text flows around the image (left or right), or it sits alone, either with the default 
none or in the centre of your page. Again, if you’ve set up image sizes to fit your page perfectly, you shouldn’t really 
need this. If an image is just half the width of your full content column though, it often looks better left or right aligned 
with the text flowing, and helps to avoid dead whitespace. 

The size is an important option. These sizes are either set by your theme, or set by you from the Settings -> Media 
page. Though it’s a matter of personal preference, I prefer to set the Medium size as the perfect fit for my content col-
umn, with large size left at the default high resolution - this gives me the option of creating a gallery-like view of photos 
should I wish to at some point.

Finally, Featured Image is the image you have chosen to represent that post. Depending on your theme, it may or may 
not be used as a thumbnail throughout. Even if your current theme doesn’t make use of it, it’s good practice to set the 
featured image in case you upgrade at a later date to one that does, or decide to hack in the functionality in your exist-
ing theme yourself. For a shining example of featured images in use, check out the MakeUseOf homepage - those 
thumbnails you see are all functioning as a featured image.

When you’ve set all the appropriate options, you can go ahead and insert the image to place it wherever your cursor 
was last in the text. I know the process of image uploading can seem a little unwieldy, but your settings are remem-
bered so most of the time you actually just need to hit upload -> insert. If that still gets you down, consider using an 
external software package to post from (see the chapter on Random Cool Tips for how to do this). 

That’s all I’m going to write about with regards to basic operation, because beyond that everything is so intuitive - you 
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simply don’t need a guide. To add a plugin, you’ll find the Add -> Plugin option on the admin toolbar, or the Plugins -> 
Add New menu option on the sidebar. Themes can be managed and installed from the Appearance -> Themes menu, 
and widget set up from Appearance -> Widgets. See what I mean about how intuitive this is?

As you install more plugins, you’ll find more menu items appearing on that left sidebar. Unfortunately, it’s up to the 
individual plugin creator to choose exactly where or which section they are placed in, so if you’re unable to find the 
options screen for the plugin you just installed, try expanding all the sections and checking each link - it’ll be there 
somewhere. I’d also encourage you to explore all of the option menu items too, just so know you get an idea of some 
of the capabilities of Wordpress.  

3.3 Adding YouTube Videos:
Wordpress has a little magic for you in this area. Rather than laboriously heading to YouTube, expanding the share 
tab and finally copying and pasting the object embed codes - just paste the URL of the the video directly into the Post 
Edit screen instead. When previewed or published, Wordpress will automatically embed the video. No messy code, no 
complicated embeds, just paste the URL and let Wordpress do the hard work. 

3.4 Widgets:

Since the user community and the number of developers working on enhancing Wordpress are so numerous, there 
are literally millions of plugins and widgets that you can add to your site. But what are widgets?

Widgets are little blocks of functionality and can range from anything as simple as showing a list of your latest 5 blog 
posts or your latest tweets, to a Facebook Connect widget that displays the avatars of your Facebook fans. 

To manage your widgets, go to the Appearance -> Widgets menu item on either your admin dashboard’s sidebar, or 
the admin bar that appears throughout the site. On the right side of the screen are the various widget areas that are 
available to you on your current theme. However, if nothing is shown here, then your chosen theme doesn’t support 
widgets. Find one that does. Some themes support multiple widgets - for example in both the sidebar and footer. 

Drag and drop widgets from the “Available Widgets” box to your sidebar or other widget box on the right. You can also 
rearrange the order of any widgets already on there. Once placed, most widgets can be customized somehow. Show 
the options by clicking the downward arrow to open that widgets options screen, and don’t forget to click save if you 
range something. Some widgets will just work as is, or don’t need customizing. 

Wordpress comes with a set of built-in widgets that perform a variety of functions, so read the descriptions and try 
them out on your site - most are self explanatory. Personally, I suggest you use at least:

• Search
• Recent Posts, showing the 5 latest posts. 
• Categories list
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• Links, to show your favourite blogs

To show the latest posts from a different blog (that isn’t necessarily yours), use the RSS widget. This will dynami-
cally pull the latest posts from the site’s RSS feed, though you will need to enter the correct feed address. For another 
Wordpress blog, just adding /feed to the end of the homepage URL should work fine. 

You might have noticed that your site already has widgets working on the sidebar by default - but the widgets screen 
shows none as active. This is because most themes have a default set that they show when the user hasn’t custom-
ized anything. If you begin to customize the widget area by dragging and dropping even just one widget, the defaults 
will all disappear to show your customized area instead. If you remove it again, the default will kick in. 

You’ll notice there’s also another box called “Inactive Widgets”. By dragging one of your existing widgets to here, you 
can “save” it - keeping the settings. You can drag multiple copies of the same widget to here and each one will be 
saved for later use. 

How do I get more widgets?

Widgets are just another kind of plugin, and many kinds of functionality-adding plugins have widgets included. If you 
want to browse the plugins that were specifically tagged as being widgets or having widgets, you can browse through 
them from the Plugins -> Add New screen, where “widgets” is one of the main tags. A far better ways of doing it is just 
to search for the kind of widget you want. Type in “twitter” (for example) and you’ll find thousands! 

3.5 Other Ways to Write Your Blog Post
Writing directly into the Wordpress interface needn’t be the 
only way you blog - try these too:

Offline Editor - Windows Live Writer:
If the whole online admin interface is a little sluggish and 
restrictive of your creative energies then you might want to 
consider this free offline editor from Microsoft. It’s easy to set 
up, and will allow you to write in a familiar Word-like interface, 
as well as drag and drop images. A lifesaver for many. Did I 
mention it’s free? (http://explore.live.com/windows-live-writer)

Sadly, there is no suitable free alternative for Mac, though on 
the premium side Ecto is the most popular choice (http://illu-
minex.com/ecto/)

Press This Bookmarklet:
Finding material to blog about is one of the hardest things to do. Often you’ll come across something interesting on the 
web and want to simply repost it, or take a quote from it, then link and comment on it. This is where a handy “browser 
bookmarklet” can come in useful. Accessible from the Tools -> Tools link on the sidebar, “Press This” will give you a 
link which you can drag to your browser’s bookmark bar to create a bookmarklet, and whenever you find something 
interesting, just hit that button.  It’ll pull in any information it can, and create a blog post for you!
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4 Wordpress and SEO                                      
I’m going to cover SEO briefly because good content alone 
is not enough to get your blog noticed, and most bloggers 
give up pretty soon if they don’t see a good number of 
visitors or feedback from them. Making sure your blog is 
optimized for search engines is only one part of the story 
though - check out the next chapter for various strategies to 
promote your blog. 

4.1 What Is SEO?
Basically, SEO means making sure the content can be 
found - so your authoritative blog post on “how to feed 
chickens” hopefully appears somewhere in the top 10 
results when a user searches Google for that particular 
phrase. Of course, no one can guarantee you’ll ever rank 
well, and ultimately it is the *quality* of your content that will 
keep you up there as a reliable source of information, but 
SEO is the launchpad from which you start and give yourself 
the best possible chance. 

4.2 Why You Should Care:
To many people, search engine optimization is some kind of black art that simply doesn’t apply to blogs - some even 
think of it as some kind of “illegal hacking” to make your website more attractive to the Googlebot. While that side of 
the subject certainly does exist (http://www.makeuseof.com/tag/5-blackhat-tools-internet-spammers-expos/), the ma-
jority of SEO techniques are simple common sense that should be applied to every website on the Internet. There are 
also some practices you need to be careful of, as they can really hurt your standing with Google. 

Let me tell you from experience that SEO is something you really have to consider from the start - it’s very difficult to 
change things once you’ve built up a backlog of blog posts indexed, and you’ve already got visitors and links coming 
in from other blogs - and you’ll be stuck in the land of blog mediocrity until finally you give up posting one day. Believe 
me, I’ve been there. 

Disclaimer: No one can really know how the Google ranking 
algorithm works, and it’s for that reason that attempting to 
game the system is foolhardy at best. What you can do is fol-
low a set of best practices published by Google themselves, 
listen to advice from those with experience, and make your 
own decisions. In the end, much of SEO is simple common-
sense, and as long as you write quality content for which the 
content is easily identifiable - by humans - then you should 
do just fine. 

4.3 First Steps:
Choose a set of keywords and if possible, focus your blog 
on a single topic. If you write lots of high quality articles on 
a single subject, and the subject is in your blog title and 
domain, then you *will* rank well for that keyword. It’s as 
simple as that. My own site, ipadboardgames.org is currently 
ranking 1st in Google for the keywords “iPad board game(s)” 
precisely because it is focused on one topic only, and has 
quality, trusted reviews that are linked to around the web. 
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But what if your site is not about a single topic - such as a general “about me” or personal blog? This is the most dif-
ficult to consider for SEO so you can expect to not rank particularly well for anything other than your own name. Try 
to write about a few unique, niche topics that you have expert knowledge on and you’ll find you get a lot of traffic from 
those which will convert to regular visitors. For example, I once owned a blog that was a mix of mediocre tech tutori-
als, but one article was about how to install Windows using Bootcamp on a Macbook when the superdrive was broken 
- at the time it was one of only a few pages around detailing the process, and was even linked to from piratebay.org, 
which literally rocketed the blog to around 500 visitors a day. 

A third type of blog you may be interesting in creating is about you, but also offering your professional services. In this 
case you still need to target some particular keywords “tree cutting Wisconsin”, but it’s important you also regularly 
publish and share your specialized knowledge on the topic, thereby establishing yourself as an expert. Simply putting 
up a “business card” site just isn’t enough anymore - you need to produce fresh content on a regular basis.  

General SEO Advice for Any Sites:
Get a personalized, unique, relevant domain name - yourdomain.com:

Depending on the type of blog you’re planning on making, the domain name is a good way to get a head-start with 
your Google rank. Basically, “exact match domains” are a key sign to Google that your site is relevant to a particular 
topic. All things being equal - an exact match of the domain will always win out against something generic. Subdo-
mains don’t count, by the way.

Set Correct Meta-Tags For Title and Description:

The page title is what appears in the user’s browser at the top of the screen - as well as the title shown in Google 
search results. Wordpress does quite well by default on titles, but you should avoid any that are too long or you may 
want to adjust the structure slightly. The meta-description is not human-readable on your blog itself, but it is used by 
Google in the search results page if you have one. If the description isn’t set, Google will attempt to extract some part 
of your page that it deems relevant to the search query (in fact, it may do this anyway and just ignore your perfectly 
crafted description if it thinks it isn’t relevant to the user at hand), so make sure you set one. By default, Wordpress 
doesn’t set a description, so you’ll need a plugin for this which I will describe later. 

Use Images To Your Advantage:

One easily overlooked area of incoming search traffic is 
from Google Image Search. In one site I’ve managed, the 
traffic shot up 100-fold overnight because of a single image 
related to recent news - with that in mind, you can lever-
age images as an untapped source of traffic. Specifically, 
the image ALT and TITLE tags need to be set so they are 
relevant to your keywords. If you page is about “feeding 
chickens”, and you have a photo of a feed mix you made, 
with the filename “DSC1001.jpg”, and no ALT or TITLE 
tags set, you are throwing away a big traffic opportunity.

An easy way to make sure you leverage this is to fix the 
relevant fields when you upload images using the Word-
press image uploader (see the screenshot), but what if 
you’ve forgotten to do it for all your existing posts? In the 
case, install the helpful “SEO Friendly Images” plugin. It 
will automatically add relevant tags to all your images, ac-
cording to the title of the post they’re attached to - it’s not 
ideal, but certainly better than nothing.  

http://wordpress.org/extend/plugins/seo-image/
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Avoid duplicate or “low quality” content:

It should go without saying that copying someone else’s content is bad, but many websites would previously do this 
automatically by simply “scraping” RSS feeds - there are even Wordpress plugins that will do this for you. Make no 
mistake though, this practice is now easily recognizable by Google and results in a swift de-indexing of the offending 
site. It is therefore absolutely crucial that you don’t copy and paste content from another source - make sure your blog 
posts are original! This doesn’t mean you can’t embed YouTube videos or quote another page, but make sure you do 
something else on top of that. 

You should also make sure that each page of your site has a significant amount of good content - Google will penalize 
you for “low quality” content if you publish a post with just two or three sentences on it. So does this mean you can’t 
post little thoughts or links you find? No, but it does mean they shouldn’t be a blog post. Consider using the “asides” 
post type of the default twenty-eleven theme which shows the posts on the blog without giving them a whole separate 
page - or post them on Twitter. A good rule of thumb is that a blog post should be at least 300 words.

4.4 Easy SEO In Wordpress:
SEO Ultimate is a fantastic free plugin (http://wordpress.org/extend/
plugins/seo-ultimate/) that I always install on any new site. There’s too 
much functionality to cover it all here, but here’s some highlights of 
what it does:

• Rewrites title tags so post titles come at the beginning, and 
allows you to write custom title tags for any archives or specific 
pages. 
• Meta description editor, to easily add relevant meta descrip-
tions site-wide and customize for individual pages and posts. 
• Avoids duplicate content by setting the rel=canonical tag 
for you (if you don’t understand what this means, it’s a way of 
telling search engines what the original page was, since Word-
press is capable of presenting the same post at multiple differ-
ent URLs)
• 404 monitor - to make sure your site remains error free. 
• Slug-optimizer - perhaps the most curious sounding feature 
ever, the slug-optimizer removes useless short words from your 
pretty permalink URLs thereby making them shorter and more 
relevant. 
• Competition researcher - not something I’ve tried myself, but this plugin has a built-in feature to inves-
tigate particular keywords or competitors URLs, helping you to figure out your own strategy. Advanced 
users only. 
• Automatic linking: internal linking is a great way to keep users on your site, but if you have a backlog 
of posts then editing them can be a pain. Use this tool to automatically link keywords to URLs, with lots of 
custom options. 
• Mask affiliate links: if you’re planning to make money from affiliate programs, you should know that 
Google generally looks down upon affiliate links and they will degrade your page score. Using this tool, 
you can hide those links so they become http://yourdomains.com/go/amazon or similar. 

Basically, it handles every aspect of SEO you will ever want, but you can disable any parts of it you don’t need. Some 
are quite advanced and certainly not topics we can cover in this book, but as you learn more about SEO, you can be 
sure you won’t need to change plugins to get that extra functionality. SEO Ultimate grows with your blog! (http://www.
seodesignsolutions.com/wordpress-seo/)
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5 Galleries and Photo Management:                  
If you’re looking to specifically create a photoblog, I strongly suggest you down-
load our companion free guide “Picture Perfect - Set Up Your Own Photoblog” 
(http://www.makeuseof.com/pages/download-picture-perfect-set-up-your-own-pho-
toblog), written by Nancy Messieh. It goes into far more detail about photoblogs 
than we could ever hope to cover here - but here’s a few of my favourite photoblog 
style themes to get you started, and an essential plugin to really supercharge the 
photo management capabilities of Wordpress.  

Tip: If you only need to embed galleries of pictures into your posts occasionally, 
Wordpress has built-in gallery functionality so you don’t need extra plugins. Just 
upload the images on the appropriate post - you don’t need to insert them, just up-
load (we call this “attaching” them to the post), then insert the shortcode [gallery] 
wherever you want the attached images to appear. 
 

5.1 Gallery and Photoblog Themes 

• Revolt Theme (http://revolt-theme.com/, left): let’s face it - who hasn’t wanted to make their blog look 
like a nodding-dog homeless man holding a signboard. Hmm, perhaps that wasn’t the best way to ex-
plain it. Check it out for yourself to get the full effect. 
• Portfolio: (http://wpshower.com/themes/portfolium/, center): straight up square grid portfolio, minimalist 
but professional.
• Imbalance: (http://wpshower.com/themes/imbalance/, right): From the makers of the Portfolio theme, 
this is a brighter, more modern theme.
• Mansion (http://graphpaperpress.com/themes/mansion/): Removes any whitespace between photo 
previews and focuses on what matters. 
• BigSquare (http://demo.wordspop.com/bigsquare/): Rather than trying to jam 20 photos on one screen, 
BigSquare simplifies things down to one photo after another complete with a quick information section on 
the side. 
• Shaken and Stirred Free (http://shakenandstirredweb.com/theme/shaken-grid-free): Allows for photos 
along with a short excerpt on the homepage.

5.2 Photo Gallery Plugin:
By default, Wordpresss will attach images to a post. For most cases this is fine, but you may find yourself wanting 
something more powerful, with the ability to manage separate albums or galleries. In that case, I recommend a plugin 
called NextGen Gallery. There’s also quite a few plugins for the NextGen Gallery plugin itself, which might hint at how 
powerful it is. 

With this installed, photo management is entirely separated from blog posts. You have Galleries which consist of one 
or more photos (one of which can be specified as the preview image for that gallery), and albums which consist of one 
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or more galleries. You can still easily embed an entire gallery or album within a blog post if you need to (“hey, posted 
these to the gallery from Sam’s wedding”), but you can also have a “photos” section, with all the galleries you have 
listed. 

Photo uploads are also more powerful, with the option of either a zip, batch or individual uploads, and you can choose 
which gallery they go in (or automatically make a new one) when you upload. 

To embed you can either use the shortcodes provided [nggallery id=?] or use the new button on your visual editor bar. 
Read more about the plugin here: http://alexrabe.de/wordpress-plugins/nextgen-gallery/, or simply install using the 
Plugins -> Add New and searching for it. 
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6 Blog Promotion:                                              
In this short chapter, I’ll take a look at some proven strategies to promote your blogs, including practical methods you 
can put into practice, some warnings, and plugins you can make use of. 

To simply write your blog isn’t enough - you need to put yourself out there in the “blogosphere” - get in contact with 
other blog owners about possible link exchanges, and comment on other blogs that interest you or are related to 
yours. 

A word of warning about commenting. Comment forms allow you to enter your name and website URL as a thank you 
link for giving feedback, but some users choose to take advantage of this by typing in their target keywords instead 
of a name - so that insightful comment might be written by “Best Dating Site”. Opinions vary in the blog community 
over the legitimacy of this, but at MakeUseOf we take a strong stance against it - if you enter your name as a set of 
keywords, rest assured you will be deleted and banned from commenting. Also, make sure your comment is actually 
adding something to the conversation - it’s easy to just write “hey, great blog post” and suddenly get your link in the 
comments, but again it’s a morally grey area. Please, don’t contribute to the mountains of web spam already out there. 

6.1 Guest Blogging
Guest blogging is also a great opportunity, whereby you write a guest post 
on someone else’s blog in exchange for a link in the article somewhere. 
MyBlogGuest (http://myblogguest.com/) is created by our own ex-writer Ann 
Smarty, and it’s a great system to find suitable blogs or even guests to post 
content on your blog (and give you a well needed holiday). 

6.2 Participate in a Blog Carnival:
A blog carnival is when a topic is given, and writers from various blogs will 
write about that topic hoping to be included in the round-up. When the car-
nival submission process is over, the leader will write a round-up post high-
lighting all the best entries and linking to them. These can be very productive 
in terms of getting new traffic, as the lead blog usually has high numbers of 
readers to nudge in your direction. 

As with commenting, try not to be too spammy and make sure the carnival 
you’re participating in is actually related to your website - it’s no good promot-
ing your Asian dating site on a gardening carnival. http://blogcarnival.com/bc/ 
is a great way to find or start a carnival and automates the process of submit-
ting and reporting entries.

6.3 Encourage Social Sharing:

Some people are really getting sick of seeing a “Like” button plastered on everything these days, but there is absolute-
ly no denying the power of social sharing for websites. Adding some social share buttons to your blog posts couldn’t 
be easier with these plugins:
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• ShareThis (http://wordpress.org/extend/plugins/share-this/) - My recommended method as it produces 
very attractive share button strips with or without share counts, and includes a recognizable all-in-one 
share button, used by thousands of websites. 

• ShareDaddy (http://wordpress.org/extend/plugins/sharedaddy/) – creates an individual button as well 
as an all-in-one share/email button. 

• AddToAny (http://wordpress.org/extend/plugins/add-to-any/) - creates a single share button that ex-
pands to show sharing links on various social networks. 

If you’re comfortable editing the theme files, you can also grab the codes directly from the relevant sites. See these 
links to generate the codes for the most popular social services:

Facebook: http://developers.facebook.com/docs/reference/plugins/like/
Google+: http://www.google.com/intl/en/webmasters/+1/button/index.html
Twitter: http://twitter.com/about/resources/tweetbutton
StumbleUpon: http://www.stumbleupon.com/badges/landing/
Reddit: http://www.reddit.com/buttons/

6.4 External Publishing on Twitter and YouTube:
Setting up a Twitter account for your official site ‘musings’ or whatever you want to call your 140 character text snip-
pets is easy - just be sure not to retweet every single one of your own articles, and read Dave LeClair’s article on the 
5 most annoying things people do on Twitter (http://www.makeuseof.com/tag/annoying-people-twitter/). YouTube is 
another fantastic source of traffic if you can produce good videos or useful content. If you’re a little camera shy like 
me, you could always try your hand at making some kind of infographic video or screencast tutorial. 
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7 Making Money From Your Blog                       
A lot of people start blogging believing that it’s an easy way to make money - just write something interesting, throw 
some ads on the page and you’ll be rolling in free cash in no time. Like all get-rich-quick schemes, the reality is quite 
different. I don’t want to put you off creating a blog to make money - if that’s your intention then fair enough. But you 
ought to know that’s it’s going to be a lot of hard work, the payback will be very little for a long time, and even after a 
few years you may just be making pocket change. Having said that, I’d like to introduce you to just a few of the ways 
in which you can monetize your blog.

Personally, I’ve been writing websites and blogging on various topics for close to 10 years now. It’s only in the last 
year or so that I actually began to earn a living doing what I love. 

7.1 Warning: The Niche Adsense Farm is Dead
Most Internet moguls have made their money so far by 
setting up vast networks of cookie-cutter sites designed 
to rake in niche Adsense profits from lucrative keywords. 
They would post thousands upon thousands of gibberish 
articles packed full of keywords, and when a user visited 
the site they would quickly find useless content and click 
straight onto to one of the more relevant looking sites in 
the Adsense block. 

Some people still think they can do the same thing today. 
I can tell you now that the days of Adsense farms, as they 
are affectionately called, are well and truly dead. In fact, 
many of those sites have now found themselves delisted 
entirely from Google, and profits have plummeted. 

That’s not to say you still can’t make some Adsense 
money for a niche topic - but if you start out with that as 
the goal, load your site with Adsense or use one of the so-
called “Adsense optimized” themes - you will fail. Google has been making some incredible advances lately, and the 
only way to climb the Google ladder nowadays is to create high quality, up-to-date, relevant content that users enjoy 
and are compelled to share. A little SEO to help you on your way certainly doesn’t hurt, but it’s the content you need to 
focus on more than anything.

Having said that, how can you make money from your blog? 

7.2 Adsense:
The classic way to monetize your blog is with Google Adsense 
advertising revenue. Head on over to http://adsense.google.com 
to apply, and use the easy tools to design your own blocks of ad-
vertising. There’s a variety of shapes and sizes on offer, but stick 
to either the classic banner shaped leaderboard or the rectangu-
lar 363x280 block. These are the positions and style I’ve found 
over the years to produce the best results:

A rectangle block of text-ads: Place these at the very start of your 
article just under the headline, and using similar colors and styles 
to the rest of your content. Users are far more likely to click on 
them if they look like a part of your content. 

Mid-Article graphic block: The same size as the unit above, but 
using graphical ads. If they’re a similar size to the pictures you 
embed in your article, even better. 
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Top of Site Leaderboard: A straight graphical banner ad at the very top of your site, under your header image or logo. 

The easiest way to add these to your page is to open up the relevant template, then copy and paste the code in where 
you want it, but if you’re uncomfortable editing theme code, use the plugin “All in One Adsense and YPN” to do this for 
you. Be warned, the plugin is set to donate a proportion of your ads displayed by default to the plugin creator, so if you 
don’t want to do this then add 0 to the Donation setting. 

7.3 BuySellAds:
Adsense is only viable for sites with extremely high traffic because 
it pays per click. BuySellBlogAds however is a third party system 
that allows you to sell ad spots directly to advertisers, and the de-
fault option is to pay for 30 days of advertising at a time rather than 
on how many impressions (a single impression being one “show-
ing” of the ad). I find these are a much better option for low to 
medium traffic but highly targeted sites. For example, on my iPad 
Board Games reviews site, I sold a number of ad spots by directly 
emailing game developers and publishers who I’d previously had 
contacts with - inviting them to purchase a premium ad spot on 
the site through the BuySellAds system. You’re also listed in the 
appropriate category on the site, so advertisers can easily find and 
target relevant sites. 

You can set your own prices, and you will receive a handsome 
75% of each ad sold. The actual mechanics of it all are taken care 
of completely by the automated system and you just need to add the code to your page. I suggest you look through 
the other listed blogs first though to get an idea of prices you could reasonably charge for your level of traffic. Sign up 
at http://buysellads.com

7.4 Affiliate Links:
The concept of an affiliate link is that you encourage your readers to purchase either in a particular store or a particu-
lar product, and in return you get a percentage of the sale. Amazon is perhaps the most famous and easiest to start 
with, primarily because no matter what you’re promoting you’re bound to find it for sale on Amazon. You don’t have to 
specifically recommend something though, even the Amazon widgets you can place on your sidebar are quite good 
performers - they’ve been programmed by Amazon to automatically tempt the reader with whatever they viewed lately 
on Amazon, or if there’s no data they’ll grab keywords from your page and automatically pull relevant products. Sign 
up at http://affiliates.amazon.com, and there are full instructions on either creating individual links or widgets, though 
explaining the process is out of the scope of this book. Unfortunately, you need to add affiliate links directly to your 
individual posts - there is no magical plugin I’m afraid. If you’re not comfortable doing this, then just copy the code for 
what Amazon calls the “Omakase” widget and paste it on your sidebar.

Amazon isn’t the only affiliate program though. ClickBank offers downloadable ebooks and software packages on a 
huge variety of products, and pays better than Amazon due to the direct marketing approach on high markup down-
load-only products. 
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8. Backup and Recovery:                                   
      

There are two main elements that need to be backed up in Wordpress - the database, and the uploaded content. Let’s 
take a look at the various methods available to you. 

8.1 Via an SSH Command Line:
If you have access to your server via SSH (a command line) then backing up and restoring your site is incredibly easy 
with a few simple commands. Unfortunately, shared hosts generally don’t have SSH access - it’s another of the privi-
leges of having your own VPS. Here’s a quick overview of the process in the event that you do have it though:

1. Login through SSH and change to your public_html or httpdocs directory (assuming you installed Wordpress in the 
root). 

2. Export the database by typing:

mysqldump --add-drop-table -u Username -p DatabaseName > BackupFilename.sql

Replace Username and DatabaseName with the appropriate details, and change the BackupFilename if you wish. Hit 
enter and type in your password. If you don’t know the usernames or passwords, check your wp-config.php as they 
will be defined there towards the start. 

3. Confirm you have your exported database file with the command

ls

You should see your BackupFilename.sql somewhere. 

4. Compress all your files and the database export using TAR command:

tar -vcf FullBackup.tar .

-vcf is going to compress and give you a visual output of what is going on, I like it to show it’s working. Make absolute-
ly sure you have that final . , or the command will fail. This will give you a full backup file named FullBackup.tar which 
you can then download via FTP or remotely send to a secure backup location. 

To restore from the FullBackup.tar, these are the steps you would take. 

1. Assuming the FullBackup.tar in stored in the httpdocs or web root of the host, unpack it first:

tar -vxf FullBackup.tar 

2. Restore your database using:

mysql -u Username -p DatabaseName < BackupFilename.sql

That’s it, you site should now be accessible and working again. The backup process can also be automated to per-
form every day or every week without needing to login and type the commands again - just follow the tutorial I posted 
at http://www.makeuseof.com/tag/automate-wordpress-backup-
simple-shell-scripting-cron/

8.2 Via Plugins:
WP-DB-Manager: mentioned elsewhere as a useful tool to 
optimize your database, WP-DB-Manager also handles back-
ups too. It’ll give you a database backup file in the wp-content/
backup-db directory. This is a semi-manual method - so you’ll 

http://www.makeuseof.com
http://ipadboardgames.org
http://www.makeuseof.com
http://wordpress.org/extend/plugins/wp-dbmanager/


WORDPRESS: YOUR ULTIMATE GUIDE

29
HTTP://MAKEUSEOF.COM
HTTP://JAMESBRUCE.ME, JAMES BRUCE

still need to download your entire site using FTP (but this plugin will have handled the database side of things for you. 
(http://wordpress.org/extend/plugins/wp-dbmanager/). 

VaultPress: This is a premium support service from the creators of Wordpress 
themselves - so you can be assured it’s rock solid and reliable. The service 
costs $15/month per site, but you’re paying for the convenience, reliability and 
ease of use. 

Backup Buddy: Another premium plugin I’ve heard fantastic things about. The 
cost is $75 one-off payment for use on up to 2 websites, and the features are 
really incredible. (http://pluginbuddy.com/purchase/backupbuddy/)

8.3 Manual Backup and Recovery:
Your written content is contained entirely within the 
database - but any media, plugins and themes you 
upload are stored in the wp-content directory. The other 
important file you need to backup is wp-config.php in 
the root - the rest of the files are standard Wordpress 
system files that could be replaced by re-downloading 
Wordpress. 

Having said that, simply downloading your entire Word-
press directory over FTP is the easiest way to backup 
files, but depending on the number and size of files 
you’ve uploaded, this could take a few hours. 

On the database side, the only way to manually back it 
up is by using PHPMyAdmin through your web host-
ing control panel. The Wordpress codex details this 
process in detail http://codex.wordpress.org/Word-
Press_Backups#Database_Backup_Instructions - but 
if you used the WP-DB-Manager plugin you will have a 
database file exported for you already, without needing 
to access PHPMyAdmin (http://wordpress.org/extend/
plugins/wp-dbmanager/)

In the event of a catastrophic failure, you need at least 
two things to restore your site:

• A full backup of all the files - or at the very least, 
your wp-content directory and wp-config.php configura-
tion file from the root. 
• A full database backup of all tables - this will be 
either a .SQL, .GZ, or .BZ2 file. 

Uploading your file backups is a simple process 
through FTP, just make sure you place everything in 
the same location again - so if your blog was originally installed into the /blog directory, make sure it goes there again 
(you can “migrate” your site to a different domain or directory, but that’s another topic entirely).

Restoring your database must again be done through the PHPMyAdmin interface, for which a comprehensive visual 
guide is already available here, so I won’t reprint it: http://www.tamba2.org.uk/wordpress/restore/ . 
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9. Optimizing and Scaling For High Traffic:          
This is a topic big enough to become an eBook all of its own, but I’m going to try and give a broad overview of the vari-
ous methods available to you once your site becomes sluggish and needs to be scaled. A lot of people are under the 
impression that Wordpress can only work for small scale blogs, but that simply isn’t true. Using a combination of vari-
ous techniques, Wordpress can scale to handle millions of requests a day. As I mentioned, MakeUseOf runs entirely 
on Wordpress, accompanied by a number of key technologies. Once you reach about 1,000 unique visitors a day, it’s 
time to start thinking about scaling your website or some form of optimizing, so read on. 

9.1 Server Upgrades:
The obvious solution to initially scale your web-
site is to migrate from shared hosting to your own 
private virtual server (check out this MakeUseOf 
article for a breakdown of the different hosting 
types: http://www.makeuseof.com/tag/website-
hosting-technology-explained/). This should be 
your first step if you’re still on shared hosting, as 
there’s simply no other miracle cure that’s going 
to help - it only delays the inevitable. My personal 
recommendation for a VPS hosting plan is the 
DV4 series from MediaTemple, and I personally 
have around 30 sites on a single $100/month plan 
there with amazing performance. 

When the need arises, a VPS hosting plan will al-
low you to upgrade instantly by adding more RAM 
or additional CPU power. 

Another benefit to having a VPS is that you’re free to switch over to the much faster backend server software called 
NGINX. This is a high performance replacement for Apache, but still free. Setting it up is absolutely out of the scope 
this book though.

9.2 External Image Hosting / Content Delivery Networks:
One key speed factor on your page is the time it takes to load 
images from your server. The page itself - the textual HTML 
content - is fairly fast, but the images will always be slow to 
load. If you have a blog which makes heavy use of images on 
the front page for example, you may find the user experiences 
sever “sequential loading” where they’re sitting there waiting for 
image after image to load, line by line in extreme cases. This 
is where the idea of external image hosting or CDNs comes in. 
CDNs are high speed data centers situated around the world 
that mirror your image (and Javascript) content, serving them 
up to visitors as required from locations as near to the user as 
possible. The effect is instantaneous loading of images, and this 
technology is absolutely key to nearly every high-traffic site on 
the Internet. Although they are an additional cost, it’s actually 
going to cost you a lot less than if you used the same amount of 
additional bandwidth on your hosting plan. The costs are very 
low - super fast MaxCDN.com offers a 1TB of transfer for $40 
(expires after 12 months), while Amazon s3 storage is a little slower but significantly cheaper. To make use of this kind 
of service you’ll need the w3 Total Cache plugin described later in this chapter.

An alternative to paid high speed data networks is simply to host your images with an external free service such as 
Flickr.com or Loadtr.com (check out the plugins list for how to do this). 

http://www.makeuseof.com
http://ipadboardgames.org
http://www.makeuseof.com


WORDPRESS: YOUR ULTIMATE GUIDE

31
HTTP://MAKEUSEOF.COM
HTTP://JAMESBRUCE.ME, JAMES BRUCE

9.3 CloudFlare - Reduce Unneeded Requests: 
Shockingly, up to a third of requests made to a website can be either malicious robots, automated scans or otherwise 
unfriendly. By cutting these out before reaching your site, you can ensure you only serve content to real users. This 
can be achieved for free with CloudFlare.com. Once you switch your name servers to CloudFlare’s, it essentially acts 
as a proxy and filter to keep out the bad guys and often results in significant speed increases on your page time. One 
minor point is that your site will see all visitors as coming from CloudFlare, so you’ll need to install their Wordpress 
plugin in order to correctly report the IP addresses etc. Owned by MediaTemple hosting, CloudFlare is also a one-click 
install if you host your website on any of MediaTemple’s plans, or you can follow our published tutorial at: http://www.
makeuseof.com/tag/protect-speed-website-free-cloudflare-service/

9.4 W3 Total Cache Plugin:
This is the big-daddy of caching plugins and has so much functionality you may find it a little overwhelming. I’ll break 
down each feature it offers, but please remember that your mileage will vary - some users report very little improve-
ment on using shared hosting for instance. I can tell you now that MakeUseOf wouldn’t be able to run without this 
plugin. Check out my previous published article here for a breakdown of the configuration: http://www.makeuseof.com/
tag/configure-w3tc-plugin-wordpress/

- Page Cache: This is the core functionality, in that it creates a static copy of your site’s posts and pages and can 
serve them rapidly to users. 
- CDN: This enables you to host not only your media files (pictures etc) but also any theme files, graphics and javas-
cript. 
- Object and Database Cache: Particularly useful for slow database servers, this prevents the same query being made 
over and over. 
- Minification: The art of making things tiny! This means removing any unnecessary spaces, line breaks and comments 
from HTML and Javascript. Generally, automatic mode works fine, but if your theme makes use of Cufon custom font 
Javascripts you’ll need to tweak it manually. 
- Browser cache and control headers: Although a lot of the Internet is cacheable, many sites simply aren’t set up by 
default to enable this. This feature makes sure your site’s pages are sending the right headers to say to the user’s 
browser “yes, you can cache this page for X days”. 

9.5 Database Optimization: 
Databases can often get messy. With constantly writing and updating entries, they accumulate temporary bits, re-
ferred to as overhead. This can grow the size of your database astronomically, and can often result in critically slow 
performance or a complete shutdown. Keeping the database tables optimized is therefore very much recommended. 
WP-DB-Manager can handle this for you as well as giving a good graphical interface for database backups. (http://
wordpress.org/extend/plugins/wp-dbmanager)

9.6 Maintenance:
 
As time goes by, security holes and flaws are inevitably discovered in any system - nothing is impenetrable. In 
fact, check out exploit-db.com if you’d like to really give yourself a fright as to how easy it is (http://www.exploit-db.
com/search/?action=search&filter_page=1&filter_description=wordpress&filter_exploit_text=&filter_author=&filter_
platform=0&filter_type=0&filter_lang_id=0&filter_port=&filter_osvdb=&filter_cve=).  By keeping your blog up-to-date 
with the latest Wordpress version, you mitigate the likelihood of your own blog being hacked or subjugated in some 
way. The latest Wordpress includes a helpful UPDATES link in the Dashboard section of the Sidebar, and on that 
screen you’ll find a complete summary as well as buttons to update all of your plugins as well as core Wordpress files. 
Don’t just hit update without some preparation first though: 

1. Backup. As Wordpress becomes more sophisticated and has ever more stringent beta testing, it’s rare 
that an update procedure will actually break your blog - but it has been known to happen. Re-read the 
steps outlined in the backup chapter, and be sure you have those backups in place before proceeding. 
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2. Bear in mind that some plugins will break. As Wordpress evolves, some functions made use of by 
plugins are deprecated, sometimes removed altogether. Again, it’s rare but some plugins will break after 
upgrading to the latest Wordpress. If this happens and your Wordpress blows up somehow, go back to 
the chapter on Recovery again, and follow the steps there to fix your blog - but you may have to find an 
alternative plugin or keep the offending incompatible plugin deactivated until it’s updated itself (so again, 
keep an eye on your updates screen!)

3. Don’t panic. Wordpress is for the most part quite a robust system, but things do go wrong. Unless 
you’ve catastrophically wiped your database through human error, no matter how bad things seem your 
blogs posts are usually never lost. 

About James Bruce                                                     
My name is James Bruce and I’m a self-taught Wordpress developer. I manage hundreds of Wordpress installa-
tions for various clients, as well as being the guy in charge of the tech side of things here at MakeUseOf.com - yes, 
MakeUseOf runs on Wordpress too. When I’m not writing articles or wrangling the MakeUseOf servers under control, 
I’m wrangling with weeds in my vegetable patch and tending my chickens - you can read more about my semi self-
sufficient lifestyle on my other blog too: selfsufficiencyguide.org/blog.
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